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Taming Word for Writers
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• Bad habits we all do while typing
• Styles: How to make them work for you
• What is a Template and why use one?
• What is the ‘Nuclear Method’?
• Search and Destroy
• Save, Save, Save
• Embedding Fonts
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• Special Formatting for Print
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Bad Habits: Tabs

Tabs do not work well for eBooks 
and mess with print formatting.

The longer we have been typing or keyboarding the more bad habits we are likely to have. 
Using tabs was necessary when using a typewriter before computers and word processors 
were invented. Now using tabs is a bad habit we need to break since there are better ways 
to indent the first line of a paragraph.
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Bad Habits: Hard Returns

Hard Returns (Shift+Enter) really mess 
up formatting and are unnecessary.

Another bad habit is the hard return. Sometimes it’s accidental, but they really need to go.

5



Bad Habits: Extra Returns

eReaders don’t handle extra returns well 
and it can all be done with Styles.

More than 2 returns will mess up eBook formatting. Really the only place you might need 
more than two returns is on the title page and copyright page of a print book. The rest can 
be done with Styles
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Bad Habits: Extra Spaces

Industry standard is now a single space between 
sentences instead of two for fiction books and 
many non-fiction genre.

This is another habit left over from the days of the typewriter and business letters. 
Fortunately we can get rid of extra spaces easily.
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‘Dirty’ vs. ‘Clean’ file

No tabs, hard returns, extra spaces or 
extra returns – just clean text.
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Why I Avoid the ‘Normal’ Style

• Any changes made to font and size can change 
other parts of your document unexpectedly

• No control over what Microsoft assumes you 
are wanting to do

• Creating your own styles gives you complete 
control over the appearance of your document 
and how it converts for eBooks and print

When I began using Word I began noticing that the ‘Normal’ Style was just not working for 
me at all. Sometimes I could change a single paragraph and things were fine, other times 
the entire document or just sections would change to match. I can be a bit of a control 
freak on some things – especially how I expect my manuscripts to look - so this was driving 
me nuts. I also don’t care for Microsoft’s beloved Calibri font at all. When I was introduced 
to Smashwords by Ink Smith who published my book ‘Dracon’s Rebirth’ I read their style 
guide and learned how to create my own styles that suit writing manuscripts much better 
than any of Word’s standard Styles.
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Normal Style

The Normal style is assuming you are writing business 
documents and defaults to MS Word’s Calibri font.

Most of Word’s preset Styles have strange text colors, lines and borders. Text color should 
always be set to automatic black. Anything else will cause problems for eBooks and for 
printing. Creating your own Styles is easy and can solve some frustration with Word. I have 
even created styles just for headers and footers.
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Adding a New Style

To add a new style there is a drop down button in the corner of the Styles Gallery bar. 
*click*
Clicking that will open a sidebar on the right side of Word. *click*
At the bottom are three buttons. The first one is New Style.
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Style Settings

The Create New Style window will open. It shows that the style is based on ‘Normal’. 
*click*
You can rename the Style so you remember what it does. The main Style I use I named ‘No 
Space’. I have another called ‘1.5 Space’ for when I format Middle Grade books. Change the 
Font in the dropdown. Times New Roman is pretty standard. Garamond and Book Antiqua 
are other standard fonts. Double check online for other fonts commonly used for books. 
Serif fonts are easiest to read because they don’t leave you guessing if the character is a 
capitol I (as in India) or a lowercase L . You will notice the word ‘Automatic’ in the text color 
box. It is important to leave this setting as Automatic so your text remains black in print 
and it will allow eReaders to change the font color according to the reader’s preferences. I 
also set the Justification to Full. I’ll explain why a bit later. *click*
Next click the Format button on the lower left and select Paragraph. *click*
The Paragraph dialogue box includes indentation which should be set for Left 0”, Right 0”, 
and Special at ‘First Line’ By .5” for your text body. If you want a style that is for a letter 
within the manuscript you can use the left and right indents to make it stand out from the 
rest of the text. Spacing for the main text body should be Before 0”, After 0” and Line 
Spacing for Single – especially for eBooks. Print books might have Line Spacing set for ‘At 
Least’ 14 pt. depending on your publisher. Check the ‘Don’t add space between paragraphs 
of the same style’ box unless you don’t have the first line indented. *click*
Click on the Line and Page Breaks tab to make certain Widow/Orphan control is checked. 
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Then click OK and OK again to save.
If your book includes diagrams or images you can use a Centered style with no indents to 
easily control how they line up on the page.
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Special Styles: Chapter Headings

There are special styles you will also want to create including one for Chapter headings. The 
important thing on Chapter Headings is you want to have a larger font size. If your main 
body text is 12 pt. then set your text size to 16 pt. If you use a different size for your main 
body make certain your Chapter Headings are about 4 pts. larger. On the Line and Page 
Breaks tab you want to uncheck Widow/Orphan control and check the other three boxes 
under Pagination. Also check the ‘Don’t hyphenate’ under formatting exceptions. The ‘Page 
break before’ puts the Chapter Heading at the top of a new page. You can use the Indents 
and Spacing tab to set the distance down the page it appears and how close the main body 
of text falls below it. 
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Special Styles: Italics

Modify an existing style to suit your needs and remove 
the ones you don’t want from the Style Gallery.

Choose styles that are close to what you want. Change the color bar to Automatic. New 
styles and modified styles can be set to Automatically update on either just the current 
document or all documents based on the template you are using. Some styles can’t be 
removed from the Style Gallery, but remember they are arranged in alphabetical order and 
you can name them so they stay at the top.
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Italics, Bold and Underline

For a single word or portion of a paragraph using the 
Font bar is okay, but for an entire paragraph use a style 
instead.

A word of caution on the Font bar: if you highlight an entire paragraph to bold, underline or 
italicize using the Font bar your entire document will be changed to match. That is why you 
need to create a Style to handle each of these. Never use the Font bar to change anything 
except a small fragment of a paragraph using the B, I or U. Doing so will create havoc with 
your formatting. Do not use anything in the Paragraph bar either. 
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• Left Justification
– Everything lines up to the left margin

• Right Justification
– Everything lines up to the right margin

• Centered
– Everything centered between the margins

• Full Justification
– Paragraph blocks line up on both margins to create a

tidy appearance and a more professional look for your
book

Types of Justification

This should put the four types of justification into perspective for you.
There are times to use each of these types of justification. I have formatted books that 
used all four types just on the first page of each chapter.
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Why Use Full Justification?

As you can see the example on the left has ragged edges. The example on the right has a 
clean appearance that makes it look more professional.
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What is a Template
and Why Create One?

• A Template is preset to produce a predictable 
result

• A Template can simplify formatting for print

• Copying your book into the Template correctly 
eliminates unseen formatting

• Using the same Template every time gives 
your books a consistent look and feel for the 
reader
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What a Template Should Have

• Title Page

• Copyright Page

• Chapter Page
– Also used for Dedication, Acknowledgements, and 

Author page

• Page Size set for print

• Margins & Gutter set for print

• Custom Styles
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Sample Template

This is a Template I created to use when formatting my books. *click*
There is a title page. *click*
A copyright page. *click
And a chapter page. It also includes an author page, but more about that later.
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Setting Margins and Gutter

Under the Page Layout Tab click the open button for the Page Setup to get started. Most 
books will be Portrait oriented.
When submitting to a publisher check their submission guidelines carefully for margins and 
page size. The gutter is the extra space on the glued edge of the page. You want the 
Multiple Pages set to Mirror Margins and apply to Whole Document.
Printers use giant sheets of paper that will yield 48 pages of 8.5” x 5.5”. Your printing cost is 
calculated based on how many sheets are needed even when the last sheet has only one 
page printed on it. The page margins and how far down the chapters start can drastically 
change the number of pages you are charged for. Some publishers have a required standard 
margin size.
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Setting the Page Size

On the Paper Tab you can set the page size. Different genres use different sizes. Checking 
online for common book sizes based on genre is a good idea.
You can also look up how many pages per printer sheet for each size. Word count for your 
genre and audience is another good thing to check out. Sometimes trimming out the ‘fat’ 
can put your book inline with the industry recommended word count as well as reducing 
your printing costs.
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Saving as a Template

From the File tab select Save As. Then select Save as type: Word Template and check the 
Maintain Compatibility box before clicking Save.
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Starting the Nuclear Method

I’ve mentioned unwanted and unseen formatting already. This is the sure fire way to clear 
out all that formatting that Microsoft doesn’t want to admit exists. I learned this method 
from the Smashwords Style Guide which was actually a more enjoyable read than I 
expected. *click*
Step one is very important: Back up your file! Sometimes I make a new folder to put all of 
the old versions of the file in including a copy of the most current file. This way I can start 
with an uncluttered folder knowing all the past is safely tucked away in the sub folder.
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How to Copy into the Template

Copying your manuscript into Notepad and then into the 
Template clears unseen formatting from the original 
document.

Open your current file, your Template file and Notepad – do not use WordPad! Note pad 
will strip out all formatting, but WordPad keeps the formatting.
The process involves copying your document from your Word file into Notepad, then from 
Notepad into your Word Template. You can Ctrl-a then Ctrl-c to copy the entire document 
then Ctrl-v to paste it. Then you will need to scroll through to find your chapter headers 
and apply the Chapter Header style to each one.
What I prefer to do is to copy chapter by chapter. That way I can catch the mid-chapter 
scene or point of view changes and add my preferred divider to each. My chapter page on 
my template includes the divider. I also will copy that chapter page enough times for the 
entire book before starting. Once you have the first chapter copied in you should save it as 
a Word document. I like adding ‘base’ to the name as I save it so it won’t overwrite the old 
file. (ex: Book base.doc)
By copying chapter by chapter you can more easily skim through for the breaks, italics and 
other sections that need a special style applied to them. Be consistent in how special 
sections are treated. If your book has a lot of letters, notes or even texts make certain they 
all get the same Style applied to them. 
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Hug a loved one

Your manuscript just survived the Nuclear method and surprisingly, it looks cleaner and

crisper than ever. Come to think of it, so do you. You’re looking pretty dang awesome

right now. You’ve got that mysterious author look that leaves your friends and fans

awestruck as they try to guess what’s going on inside your head.

If this is your first time formatting, before you progress to Step 7, I want you to take a

quick break and hug a loved one. Whether they’re of the fleshy, furry or feathered

variety isn’t important. What is important is to tell your loved one you’re about to

disappear for an hour or two, and you’d prefer they not interrupt you unless Oprah calls,

someone’s choking, or the roof is on fire. Also tell them if they hear grunts or screaming

they’re to bring you a glass of warm milk or chamomile tea pronto, followed by a

shoulder massage. Got that? Tell ‘em Mark said so.

I care about your mental well-being, and I want this to be fun. You’re about to publish

an ebook!

All set? Okay, let’s go.

Quote from Smashwords Style Guide by Mark Coker

This is important. At the very least save your work and take a break.
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Cleaning up Using Replace

Now that you have cleaned up the formatting you can’t see it is time to clear up what you 
can see: the tabs, extra returns and extra spaces. Start by clicking Replace in the Editing bar 
on the Home tab. For most things the ‘Replace all’ button is your best friend.
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Double tap is not just for zombies

This is why. Although it looks like just replaced nothing with nothing what I did is replaced 
double spaces with a single space 11,690 times with the click of one button. *click*
You might have to do this several times before you it says ‘0 replacements made.’
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What to put into Replace

• For Tabs - ^t replace with nothing

• For extra lines - ^p^p replace with ^p

• For extra spaces
– [space][space] replace with [space]

– .[space]^p replace with .^p

– ^p[space] replace with ^p

• Can search for quotes and apostrophes to make 
them a consistent form “ vs. “

This can also be useful when checking the spelling of names or consistent use of words to 
denote different languages like using the term infant vs. baby. The version of quotation 
marks is personal preference, but make certain they are consistent. The ones on the left are 
called ‘smart quotes’. In my books dragons speak through thought so I decided to use 
apostrophes in place of quotation marks to denote speech through thought rather than 
italics which can be used when a character thinks to themselves.
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When to Save

• Save as a new Word document once you have 
copied in your first chapter to leave your 
template clean for the next book

• Give your document a new name so you don’t 
overwrite your original ie: Book v1 or Book v2

• Save a copy for your eBook before putting in 
headers and page numbers for your print book 
ie: Book v1e for eBook and Book v1p for print

Save often. Make certain auto save is turned on. Save and then lock your keyboard when 
you leave your computer – especially if you have cats. Saving your document with a new 
name can allow you to go back to a prior version if something goes wrong. It doesn’t hurt 
to have it saved in a couple of places just in case. I’ve used USB drives for short term 
backups, but besides having Word auto backup on my hard drive I have a remote hard drive 
located in another room that I can back up to like my own personal cloud.
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Embedding Fonts

Once your have completed copying your manuscript into the template and cleaning it up it 
is time for some finishing touches before you are ready to upload your eBook. Regardless 
of what font you choose you need to embed your font to make certain you don’t wind up 
with blank rectangle boxes in place of letters. Word is pretty determined to make you use 
their Calibri font. Start by selecting ‘Options’ on the File tab.
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Embedding Fonts

Under Word Options select Save and you will see this window. The bottom section has 
deals with embedding fonts. Check mark the ‘Embed fonts in the file’ box and make certain 
the other two boxes are unchecked. This is especially important when uploading to Ingram 
Spark, Lightning Source or other printers, but also good for eBooks. Then click the OK 
button
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Inserting Photos

Not all photos print well. Choose a photo with contrast 
in the background or it will come out too dark.

Select the Insert tab and click Pictures. A window will pop up for you to search for your 
photo. It can be helpful to copy it into the folder or onto your desktop so you know where 
to find it. This photo is way to dark. Long story, but when taking your author photo make 
certain the photographer knows you need a background that is high contrast or this is what 
you get. A light background will be much better than a dark one unless you are wearing 
very light colored clothing.
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Where to Find Text Wrap

This is the same photo lightened up. Eventually I’ll get a better photo taken against a lighter 
background. Click on the photo so it is selected and click on the Picture Tools/Format tab. 
Under the Wrap Text select More Layout Options.
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Controlling the Text Wrap

On the Layout window that pops up select either square or tight for Wrapping style. I 
recommend that you wrap either Right only or Left only depending on your preference. 
How far the text is from the photo can be adjusted if you want to. Then click OK.
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The Fork in the Road

Now is the time to save your eBook version using an e at the end of the file name. Your file 
is clean, formatted and ready to go. If you decide to upload individually to Amazon, Barnes 
& Noble, and other eBook sites you will need to convert it to their preferred file type 
before uploading. I like Smashwords because 1) it is free, 2) with a single upload it converts 
to all eBook formats, 3) it distributes to all eBook sites of your choosing including the 
system libraries use – all except Amazon. Check Amazon’s current requirements and 
download the correct format and upload that to Amazon. 
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Example of a Title Page for Print

Now you can save another copy with a p for print at the end. Now that you are working 
with the print version of your book you need to space out the title page and copyright 
page. You can use as many returns as you like in the print version. Leave ample space for 
signing if you want to sign on the title page. At this point if you don’t feel comfortable with 
the more complicated business of sections, headers and footers be assured your publisher 
or formatter will be happy to receive this clean file to format for print.
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Section Breaks in Print Formatting

If you are adventurous and feel comfortable with a little experimentation I’ll give you the 
basics. I recommend saving now and then saving as a new version to experiment with. All 
of your front matter including dedications and acknowledgements should be included with 
the title and copyright pages in the first section. You will not put headers or footers in the 
first section. To add a section put your cursor at the end of the front matter. Sometimes it’s 
a good idea to put a return after that last line before the section break. Go to the Page 
Layout tab and click on Breaks in the Page Setup bar. In the dropdown select Next Page 
under Section Breaks. If the text on the last line stretches out put in another return before 
the section break. You might have to delete a page to move the Chapter Header to the first 
page of the section. Watch your page count in the lower left corner of Word to make 
certain you don’t wind up with ‘invisible’ pages from creating the sections. This is where 
you might have to experiment a bit to eliminate the invisible pages that will show up when 
printing.
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Header and Footer Settings

To enter the header/footer double click in the top or bottom margin of a page. You want to 
set the Options to Different First Page, Different Odd & Even Pages and Show Document 
Text. On the second section that starts at Chapter One, clear the ‘Link to Previous’ on the 
first three pages in both the headers and footers. This is very important to do before adding 
any text or numbering.
For the headers definitely center them. I create a header style that is centered with 6 pt. 
after the paragraph and no indentation. You can have your pen name on the left page and 
the book title on the right page. Leave the first page header blank.
Centering the numbering at the bottom is the easiest to do. If you decide to put the 
numbering in the corners create a right footer and a left footer style to make things a bit 
easier. Again no indentation, but add 6 pt. before the paragraph. You will want to format 
the page numbers to start at 1. You will need to add the page numbers to the first three 
pages of the first chapter, but leaving the footers for the rest of the sections on ‘Link to 
Previous’ means you shouldn’t have to do more to the page numbers besides checking to 
make certain no numbers get skipped – which means ‘invisible’ pages. As for the headers 
you might be able to leave them linked after the first chapter, but be prepared to unlink as 
necessary. Remember that you will need to Close the Header and Footer to check your 
work.
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Review
• Bad habits we all do while typing
• Styles: How to make them work for you
• What is a Template and why use one?
• What is the ‘Nuclear Method’?
• Search and Destroy
• Save, Save, Save
• Embedding Fonts
• Photos
• Special Formatting for Print

40



Thank you for attending 
Formatting Made Easy

All examples are from work by V.J.O. Gardner both published and unpublished. 
All rights reserved. This work is copyrighted and may be used for reference only.
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